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IMPORTANT SAFETY WARNINGS
The Magellan Triton is a navigation aid designed to assist you in arriving at your selected destination. 
When using the Magellan Triton, these safety rules must be followed to prevent accidents that can 
result in injury or death to yourself or others:

IN THE INTERESTS OF SAFETY, DO NOT USE THIS NAVIGATION DEVICE WHILE 

DRIVING A VEHICLE.

Please do not try and change any settings on the Magellan Triton while driving. Come to a 
complete stop or ask a passenger make any changes. Taking your eyes off the road is dangerous 
and can result in an accident in which you or others could be injured.

USE GOOD JUDGEMENT

This product is an excellent navigation aid, but does not replace the need for careful 
orienteering and good judgement. Never rely solely on one device for navigating.

USE CARE

The Global Positioning System (GPS) is operated by the U.S. Government, which is solely 
responsible for the accuracy and maintenance of the GPS network. The accuracy of position 
fixes can be affected by the periodic adjustments to GPS satellites made by the U.S. 
government and is subject to change in accordance with the Department of Defence civil GPS 
user policy and the Federal Radionavigation Plan. Accuracy can also be affected by poor 
satellite geometry and obstructions, like buildings and large trees.

USE PROPER ACCESSORIES

Use only Magellan cables and antennas; the use of non-Magellan cables and antennas may 
severely degrade performance or damage the receiver, and will void the warranty.

LICENSE AGREEMENT

Magellan Navigation Inc. grants you, the purchaser, the right to use the software supplied in 
and with Magellan Navigation GPS products (the “SOFTWARE”) in the normal operation of the 
equipment. 
The SOFTWARE is the property of Magellan Navigation and/or its suppliers and is protected by 
United States copyright laws and international treaty provisions; therefore, you must treat this 
SOFTWARE like any other copyright material.
You may not use, copy, modify, reverse engineer or transfer this SOFTWARE except as expressly 
provided in this license. All rights not expressly granted are reserved by Magellan Navigation 
and/or its suppliers.
Operation is subject to the following two conditions: (1) this device may not cause interference, 
and (2) this device must accept any interference, including interference that may cause 
undesired operation of this device.
No part of this guide may be reproduced or transmitted in any form or by any means, electronic 
or mechanical, including photocopying and recording, for any purpose other than the 
purchaser’s personal use without the prior written permission of Magellan Navigation Inc.
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IMPORTANT SAFETY WARNINGS
Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the 
user’s authority to operate this equipment.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. End users must 
follow the specific operating instructions for satisfying RF exposure compliance.

This transmitter must not be co-located or operating in conjunction with any other aerial or transmitter.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with 
non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception. The user is 
cautioned that changes and modifications made to the equipment without the approval of manufacturer could void the user’s 
authority to operate this equipment.

The Magellan Triton must be installed and operated at a distance no closer then 8 inches (20 cm) from the user.

This Class B digital device meets all requirements of the Canadian Interference-Causing Equipment Regulations.
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IMPORTANT SAFETY WARNINGS
IC statement

Operation is subject to the following two conditions:

1. This device may not cause interference.
2. This device must accept any interference, including interference that may cause undesired operation of the 

device.

IMPORTANT NOTE:

IC Radiation Exposure Statement:

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. End users must follow 
the specific operating instructions for satisfying RF exposure compliance. 

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The information provided in this document is subject to change without notice. Improvements and enhancements to the 
product may occur without any formal notification. Check the Magellan website (www.magellanGPS.com) for product 
updates and additional information.

Underwriters Laboratories Inc. (“UL”) has not tested the performance or reliability of the Global Positioning System (“GPS”) 
hardware, operating software or other aspects of this product. UL has only tested for fire, shock or casualties as outlined in 
UL’s Standard(s) for Safety for Information Technology Equipment, UL60950-1. UL Certification does not cover the 
performance or reliability of the GPS hardware and GPS operating software. UL MAKES NO REPRESENTATIONS, 
WARRANTIES OR CERTIFICATIONS WHATSOEVER REGARDING THE PERFORMANCE OR RELIABILITY OF ANY GPS 
RELATED FUNCTIONS OF THIS PRODUCT. 

Maximum normal use temperature is 66°C.

 

© 2008 Magellan Navigation, Inc. All rights reserved. The Magellan Logo, Magellan, and Magellan Triton are trademarks of 
Magellan Navigation, Inc. No part of this user manual may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, including photocopying and recording, for any purpose other than the purchaser’s personal use, 
without the prior written permission of Magellan Navigation, Inc.
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Overview

Thank you for your purchase of the Magellan Triton GPS receiver.  The Magellan Triton was designed 
for the outdoor enthusiast with all the features needed to make your outdoor adventures safe and 
enjoyable.

Be sure to register your Magellan Triton at www.magellangps.com to be kept informed of possible 
software updates and new features as they become available.  Also visit the Magellan Triton support 
page at www.magellangps.com/support/ and select your Magellan Triton model for additional 
information and tips on the use of your Triton.

Features of the Magellan Triton 1500

2.7” color touch screen – The brilliant colors and touchscreen controls provide an easy-to-read 
display that makes selecting functions as easy as touching the screen.

Ease-of-use – Simple menus and an intuitive interface makes using the Magellan Triton easy for 
first time GPS receiver users while still keeping all the functions experienced users expect to see.

Routes and tracks – Create a single leg Go To route, a route with multiple destinations or just use 
the backtrack function to follow your footsteps back to your point of origin.  

3-meter accuracy – The SiRFstarIII™ GPS chipset and an integrated multidirectional antenna 
offer superior GPS accuracy.  The Magellan Triton is also WAAS and EGNOS-capable, taking 
advantage of the Wide Area Augmentation System for improved accuracy.

Built-in map – A built-in base map of the continental United States and Canada display major 
highways, city centers, bodies of water and much more.

Ability to add detailed maps – Access optional detail maps for marine cartography, topographic 
maps, as well as feature-packed National Geographic maps from an SD card that can be installed 
in the Magellan Triton.

SD-card expansion - Use an optional SD memory card to upload detailed maps and store media.

Flashlight - Light your way with a powerful LED flashlight. Low power consumption helps 
maximize battery life.

Voice recorder - Microphone and speaker enable you to record audio notes and attach them to 
waypoints, share with friends and family or easily find your way back next time.

Digital music player - Upload your digital music to an optional SD card and enjoy a customized 
soundtrack as you explore. Plug in any standard headphones (optional accessory) for clear private 
listening.

External antenna connector - Simply plug in an external antenna (optional accessory) in your boat 
or off-road vehicle for enhanced GPS signal reception.

Audio jack - Plug in any standard 1/8" headphones (optional accessory) to enjoy clear private 
listening of your digital music, voice notes and other recordings.
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A Backlight and Flashlight Button
B Hold Switch (under protective rubber cover)
C External Antenna Connector (under protective rubber cover)
D Data Connector  (Back)
E Stylus
F Zoom - (Zoom out) Button
G Page / Go To Button
H Esc (Escape) Button
I Zoom + (Zoom in) Button
J Menu Button
K Enter Button / Cursor Control
L Microphone
M Power Button
N SD Card Slot (under protective rubber cover)
O Headphone Jack (under protective rubber cover)
P Reset
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Specifications

PHYSICAL

PERFORMANCE

POWER

Case Rubber armored impact-resistant plastic, water-resistant seal, IPX-7
Base Map Built-in base map of the continental United States and Canada.
Size 5.75" x 2.5" x 1.13"  (14.6 x 6.35 x 2.87 cm)
Weight 8.0 oz (227 g) - w/ battery
Display 2.7" (6.86 cm) diagonal, QVGA (240X320) resolution and touch screen 

(LED backlit)
Data Storage Secure Digital (SD) Card (optional accessory)
Antenna Built-in multidirectional patch (or optional external antenna)
Keypad Nine direct-access keys
Operating Range 14° to 140°F (-10° to 60°C)

Receiver SiRF Star III™ 20 channels, WAAS/EGNOS
Acquisition Time Hot: 20 seconds, Cold: 60 seconds, Initial: 2 minutes
Update Rate Once per second
Accuracy 3 to 5 meters (10 - 16 feet) - WAAS/EGNOS, < 7 meters (15 feet) - GPS 

only
Languages English, French, German, Dutch, Danish, Swedish, Spanish, Italian, 

Portuguese, Finnish, Norwegian
Coordinate Systems Latitude/Longitude, UTM, OSGB, Irish, Swish, Swedish, Finnish, German, 

French, USNG, MGRS, Indian, Nederlands

Source Two AA Batteries (included)
Battery Life Up to 10 hours
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Fundamentals

Turning the Triton on

1. Press and hold the power button until the Triton 
splash screen is displayed.

Turning the Triton off
When turning off the Triton you can select to have it 
shutdown or go into suspend mode.

1. Press the Power button and the Triton will begin the 
shutdown sequence.

2. To place the Triton in suspend mode, press Enter 
before the shutdown sequence is complete.

3. To cancel the shutdown sequence and return to the last viewed screen, press any key or tap 
the screen.

4. If after 5 seconds no key has been pressed, the Triton will shutdown.

Setting the display backlight intensity
Depending upon the lighting conditions you are in you may need to change the backlight settings for 
the display.  There are five levels of backlight intensity, press the backlight button momentarily to 
step through each level of backlight intensity.

1. Press the backlight button momentarily.  The 
backlight intensity will increase 20% until it reaches 
the maximum intensity.  Pressing the backlight 
button again will turn off the display backlight.

Please note that reducing the backlight setting will increase 
the battery life for the Triton.  Refer to the section in this 
chapter on Battery Life for other tips on extending the 
Triton’s battery life.  Also note that the backlight and the 
flashlight use the same button on the Magellan Triton.  Press 
the button momentarily to control the backlight setting, press 
and hold the button to turn the flashlight on and off. 

Setting the Time Zone
The time and date information will be computed from information from the GPS satellites so there is 
no requirement for you to input any time or date information.  However, to make the time accurate 
for your location you must select the correct time zone.

1. From the Map screen press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile you want to use.  (See the chapter on Profiles for more information.)

5. Press the PAGE / GO TO button to change the page to the Display page.

Press button 
momentarily
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6. Scroll down the page and select the Time Zone field.

7. From the drop-down menu, select your current time zone.  (Time zones are not changed 
automatically when travelling.  If you travel to an area with a different time zone, you will 
need to change it here for accurate time information.)

8. Repeat the process for the Daylight Savings field.

9. Press the PAGE / GO TO button until the Info page is displayed.

10. Select Activate Profile.

Changing Languages

1. From the Map screen press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile you want to use.  (See the chapter on Profiles for more information.)

5. Press the PAGE / GO TO button to change the page to the Display page.

6. Scroll down the page and select the Language field.

7. From the drop-down menu, select the desired language.

8. Press the PAGE / GO TO button until the Info page is displayed.

9. Select Activate Profile.

Sleep Mode (Backlight Timer)

To conserve battery life the Triton will go into Sleep Mode at a preset interval when no keys have been 
pressed.  

Waking up the Triton from Sleep Mode

1. Press any key and the Triton will wake up, turning the backlight on to the previous setting.

Setting the Backlight Timer

1. From the Map screen, press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile desired.

5. Select the Display Options icon at the top of the 
display. Select Backlight Timer.

6. Choose the interval that the backlight will turn off 
with no keys pressed.  You can also select Off if you want the backlight to remain on as long 
as the Triton is turned on.

Display Options Icon
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Automatic Power Off

The Triton can be set to automatically go into suspend mode when no keys have been pressed.  This 
saves battery life if you forget to turn off the Triton.

Setting the Power Off Timer interval.

1. From the Map screen, press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile desired.

5. Select the Display Options icon at the top of the display.

6. Select Power Off Timer.

7. Choose the interval that the Triton will turn off with no keys pressed. You can also select Off 
if you want the Triton to not turn off automatically.

Hold Switch

Sometimes you may find that you want the Triton to keep computing your position but you are keeping 
it in your backpack or some other area where the keys might be pressed accidently.  To prevent 
accidental key presses, the Triton has a Hold Switch that disables the keys and the touchscreen but 
the Magellan Triton will continue to compute position information.

Setting the Hold Switch

1. Lift the protective cover from the Hold Switch.

2. Slide the Hold Switch down to turn off the keys and touchscreen, 
up for normal operation.
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Flashlight

The Triton has a three LED flashlight located at the top of the receiver.  This can be used in 
emergency situations when you need quick access to a flashlight.  To conserve battery life it is 
recommended that you use the flashlight only when needed.

Turning the flashlight on or off.

1. Press and hold the Flashlight button for at least 4 
seconds to turn the flashlight on.

2. Press and hold the Flashlight button for 4 seconds 
again to turn the flashlight off.

Note that the backlight and the flashlight use the same 
button on the Magellan Triton.  Press the button momentarily 
to control the backlight setting, press and hold the button to 
turn the flashlight on and off.

Menus

Accessing the features of the Magellan Triton is done through the Main Menu. The Main Menu has 
three options; Go To, Create and View.  Selecting one of these menu options brings up the menu for 
the corresponding function.  

Accessing the Main Menu

1. From the Map Screen, press MENU.

The Go To Menu has six options; Waypoint, Place, Trail, Geocache, Route, and Trips.

The Waypoint option provides a way to create a Go To route to a waypoint that has been saved 
to the Magellan Triton. 

The Place option is used to select a destination waypoint that has been either preloaded into 
the Magellan Triton as part of the internal base map or a destination waypoint found on a 
detailed map that have been loaded on an optional SD card.

The Trail option displays trails that you have saved previously. You can select the trail that you 
would like to follow from the list.

The Geocache option allows you to select a saved geocache waypoint and use it as the 
destination waypoint for a Go To route.

The Route option displays routes that you have created previously that you can select from to 
activate. 

The Trips option will be available in a future update.  Check the Magellan website at 
www.magellangps.com for information on updates to your Magellan Triton.

The Create Menu has the same options as the Go To Menu but these are used to create waypoints 
and multileg routes that can be saved by the Magellan Triton.

Use the Waypoint option to create a waypoint from your present location, by selecting a point 
on the map or by entering the coordinates for a known waypoint.

The Trail option provides a way for you to save your current track (a record of your travels since 
the last time track was cleared) as a route that you can use again to follow your current 
journey.

Press and hold 
for 4 seconds.
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The Geocache option allows you to add new geocache locations from your present position, by 
selecting a point on the map or by entering the coordinates of a known geocache.

The Route option is used to create a route with multiple legs.  These routes generally begin at 
your current location and go to a series of waypoints that could have been created and saved 
in the Magellan Triton from earlier trips or waypoints that are available from the base map or 
an optional detailed map. 

The Trips option will be available in a future update.  Check the Magellan website at 
www.magellangps.com for information on updates to your Magellan Triton.

The View Menu has options for many of the support functions and tools found in the Magellan Triton.

The Local Info option provides access to information about the best hunting and fishing times 
as well as solar and lunar rise and set times for the location of your cursor.

The Profiles option is used to customize the settings of the Magellan Triton for a particular 
activity; hiking, marine use or geocaching.

The Maps option displays a list of the base maps and available detail maps, that can be used.

The Media option contains the functions for taking and viewing photographs and movie clips.  
Other functions of the Media option are creating audio clips and playing MP3 music files.

Use Settings to access navigation settings, adjust volume and brightness, select connectivity, 
view memory details, as well as perform diagnostics.

Navigation Screens

The Triton has six navigation screens and a Satellite Status screen that can be accessed by pressing 
the PAGE / GO TO or ESC button  The Navigation Screens will be discussed in detail in the Navigation 
Screen chapter of this manual.

Navigation Screen options menus

The Map and Speedometer navigation screens have options menus that are associated with them 
providing access to additional functions.  

Accessing the Map Screen Options Menu

1. While viewing the Map screen, press ENTER.

2. Press ESC to close the options menu.

Accessing the Speedometer Options Menu

1. While viewing the Speedometer screen, press MENU.

For Speedometer you can: Reset Odometer, Reset Trip Odometer, Reset Speed.

2. Press ESC to close the options menu.
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Data Fields

The Map screen, the Large Data screen, the Compass, and the Satellite 
Status screen have data field that can be customized to display 
navigation information.  You can change what information is being 
displayed from 20 different data type options.

Accessing the Data Fields on the Map Screen

1. While viewing the Map screen, tap on the arrow (circled in 
red) in the lower right corner.

2. Two data fields will appear.  Tap on it again and two more 
data fields appear.  A total of four can be displayed.

Customizing the Data Field

1. While viewing a screen that has customizable data fields, press ENTER.  The first data field 
will be displayed in pale orange.

2. Select the field you want to change and with it highlighted, press ENTER.

3. Select the data type desired from the list shown and press ENTER.

4. The Triton will return to the original screen with the data field customized to display the 
information selected.

Selecting Maps
Detailed maps, including National Geographic maps, can be purchased and downloaded from the 
Magellan Store and loaded automatically into your Magellan Triton from an SD card.  You will need 
to select the detailed map you want to use to activate it.

1. From the Map screen, press MENU. 

2. Select View.

3. Select Maps.

4. Select the detailed map from the list that you want to activate and press ENTER.

5. The font for the detailed map will turn blue when it is active.

6. Select the green checkmark.
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Battery Life

The following are things you can do to conserve the battery life in your Magellan Triton.

Turn off backlight during daytime use. 

1. Press the Backlight button (top left side of the receiver) to cycle through the backlight 
intensities.

(Alternate method)

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Display page.

6. Select Backlight Level.

Select a low backlight level during nighttime use.

1. Press the Backlight button (top left side of the receiver) to cycle through the backlight 
intensities.

(Alternate method)

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Display page.

6. Select Backlight Level.

Select a short backlight timer setting during nighttime use.

1. Press MENU.

2. Select View.

3. Select Profiles.

4. Select a profile.

5. Press PAGE / GO TO to select the Display page.

6. Select Backlight Level.
Fundamentals 10



Connect to PC using USB cable (if possible).

1. Connect the Magellan Triton to a computer using the USB cable supplied with the Magellan 
Triton.

2. Select POWER ONLY from the options menu that is displayed.

Connect to Vehicle Power Adapter (optional accessory).

1. Connect the Magellan Triton to the optional vehicle power adapter.

2. Select POWER ONLY from the options menu that is displayed.

For optimal performance, use only brand name AA alkaline or lithium batteries.

Rechargeable AA batteries are not recommended.
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Navigation Screens

The Magellan Triton has five navigation screens and a Satellite Status screen.  The Navigation screens 
provide you with information to assist you in your journeys.  

Selecting Navigation Screens

1. While viewing one of the Navigation screens, press PAGE / GO TO (next screen) or ESC 
(previous screen) to select the navigation screen you are looking for.

Map Screen

The Map screen displays your present position at the arrow cursor along with map detail information 
provided from the base map.  (If you have an optional Detail Map loaded and are in an area covered 
by the detailed map, the map information from the detailed map will be displayed.)  

Waypoints (user-created or preloaded in the map) will be displayed by their icons on the screen.

A visual indication of your movements (track) is displayed on the 
map as an orange line with white dots. If the track has been saved, 
it appears as a blue dashed line (color is user customizable).  Also, 
if you have a route activated, it is shown on the map as solid yellow 
lines. (The trail colors can be modified.)  A pink line is also 
displayed that indicates the Position Destination Line.  The 
Position Destination Line is a straight line displaying LOS (line of 
sight) from your current location to the next destination waypoint.  
At the top right of the map is a north indicator that rotates to 
indicate north from your present heading and the map scale 
(circled) is displayed in the bottom left corner.  The header bar 
shows battery level, time of day and satellite signal strength.

Changing the Map Scale

1. While viewing the Map screen, press + ZOOM or ZOOM - to step through the different map 
scale levels.

Data Fields.  The Map screen can display up to four customizable data fields.  

Displaying the Map Screen Data Fields

1. Tap on the tab in the lower right corner of the screen and the 
first two data fields are displayed.

2. Tap again on the tab and two more data fields will be 
displayed.

3. Tap once more to hide all the data fields.
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Customizing the Data Fields

1. With the data fields displayed, tap on the field you want to change.

2. Select the data that you want to be displayed.  (You can do this by either tapping on the field 
or use the cursor control to highlight the field in orange and press ENTER.)

3. The Map screen will be displayed with the data field changed to the type selected.

4. The Map screen has two menus associated with it; the Main Menu and an Options Menu.  
The Main Menu is used to access the features of the Triton and the Options Menu can be 
used to create a waypoint at the cursor position, set a backtrack route or provide local 
information for the cursor position  (Other functions are also available if you have a route 
active or if you are in panning mode.)

Accessing the Main Menu

1. Press MENU while viewing the Map screen.  The Main Menu will appear.  Press ESC to close 
the menu and return to the Map screen.

Accessing the Options Menu

1. Press ENTER while viewing the Map screen.  The Options Menu appears.  Select the 
function desired or press ESC to return to the Map screen.

Map Cursors

There are two cursors that can be displayed on the Map screen.

The arrow cursor displays your present position (or last known position) on the map with the 
arrow pointing in the direction you are heading.  

The pan cursor (target icon) can be moved to any position on the map by using the cursor 
control or by tapping on the screen.  A small red dot around the cursor indicates the direction 
to your present position.  The pan cursor is used for adding waypoints to the map or creating a 
go to route from your present position to a spot on the map.  If you view local information 
while in pan mode, the information displayed will be for the position of the cursor. 

Cancelling Pan

1. When you are done panning around the map, press ESC to return the cursor to your present 
position.
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Viewing Best Fish and Hunt Times
If you are in Pan mode, this information will display for the location of 
the cursor position otherwise the information is for your current 
location.

1. While viewing the Map screen press ENTER.

2. Select Local Info. 

3. Select Fish and Hunt.

4. Select the arrows at the top of the display to scroll through the 
dates.  Tap the date displayed at the top of the display to use 
the calendar to select a date.

5. Press the green checkmark when done.

Viewing Sun and Moon Rise and Set Times
If you are in Pan mode, this information will display for the location of 
the cursor position.  While in normal mode, this information is for your 
present position

1. While viewing the Map screen press ENTER.

2. Select Local Info.

3. Select Sun and Moon.

4. Select the arrows at the top of the display to scroll through the 
dates.  Tap the date displayed at the top of the display to use 
the calendar to select a date.

5. Press the green checkmark when done.

Current Location Screen

The Current Location screen contains information about your present 
position as well as the distance and bearing to your next waypoint 
destination if there is an active route being used.

To reset the odometer, go to the Speedometer screen and follow the 
instructions provided for resetting the odometer.
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Large Data Screen

The Large Data screen displays four customizable data fields in a large, 
easy-to-read format.  This screen is a handy option for those times that 
you need to position the Magellan Triton at a distance but still need to 
view navigation information.

Customizing the Data Fields for the Large Data Screen

1. Select the field you want to change by highlighting the field and 
pressing ENTER or by tapping on the field.

2. Select the data that you want to be displayed.  (You can do this 
by either tapping on the data field or use the cursor control to 
highlight the data field in orange and press ENTER.)

3. The Large Data screen will be displayed with the field changed to the type selected.

Speedometer Screen

The Speedometer screen displays the current speed and the maximum 
speed in a large, easy-to-read format.  It also displays an odometer and a 
trip odometer so you can see the distances traveled.  The maximum 
speed, the odometer and the trip odometer can be reset following these 
instructions.

Resetting the Odometer

1. While viewing the Speedometer screen, press MENU.

2. Select Reset Odometer.

3. The Speedometer screen is displayed with the odometer reset to 
zero.

Resetting the Trip Odometer

1. While viewing the Speedometer screen, press MENU.

2. Select Reset Trip Odometer.

3. The Speedometer screen is displayed with the trip odometer reset to zero.

Resetting Maximum Speed

1. While viewing the Speedometer screen, press MENU.

2. Select Reset Speed.

3. The Speedometer screen is displayed with the maximum and average speeds reset to zero.
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The Compass Screen

The Compass screen displays information about your heading (the 
direction you are travelling) and bearing (direction to your next waypoint 
destination if a route is active) in a familiar graphical format.

Outside the compass are icons indicating the position of the sun and the 
moon relative to your position and heading.

Inside the compass there are two arrows that can be displayed.  The large 
green arrow is your heading and is displayed only while moving.  The 
smaller, black arrow is the bearing to your next destination waypoint if 
you have a route activated.  When the two arrows are lined up together, 
you are moving directly towards your destination. (Note that the compass 
will rotate relative to North.)

The two data fields at the bottom of the display are customized by 
following the instructions provided.

Customizing the Data Fields for the Compass Screen

1. Select the field you want to change by highlighting the field and pressing ENTER.

2. Select the data that you want to be displayed.  (You can do this by either tapping on the data 
field or use the cursor control to highlight the data field in orange and press ENTER.)

3. The Compass screen will be displayed with the field changed to the type selected.

The Satellite Status Screen

The Satellite Status Screen graphically displays the satellites and their 
signal strength that is being used to compute your location. This screen 
shows when you are getting strong, weak, or poor signal reception. Green 
satellite icons represent satellites that are being used to compute your 
position while yellow (good), white (medium), and red (poor) icons show 
signal strengths of other available satellites. Signal levels are also 
represented at the bottom of the screen as colored bars.  

The numbers indicate the GPS satellite ID while “W” indicates WAAS 
(Wide Area Augmentation System) satellites.

There are also two customizable navigational screens displayed at the 
bottom of the display.

Customizing the Data Fields for the Satellite Status Screen

1. Select the field you want to change by highlighting the field and pressing ENTER.

2. Select the data that you want to be displayed.  (You can do this by either tapping on the data 
field or use the cursor control to highlight the data field in orange and press ENTER.)

3. The Satellite Status screen will be displayed with the field changed to the type selected.
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Explanation of Data Field Types

Latitude (LAT)

Latitude is the coordinate measurement of North and South.  The latitude lines run parallel to the 
equator.  They range from 0° (the Equator) to 90° N/S (the Poles)

Longitude (LON)

Longitude is the coordinate measurement of East and West. The longitude lines run to and from 
the poles. They range from 0° (Prime Meridian) to 180° W/E (the International Date Line).

Heading

Heading is the direction a user is moving or facing, measured in 
degrees relative to north. This tells you what direction you are 
going. 

Bearing

Bearing is the direction of a destination from the user, measured 
in degrees relative to north. This tells you what direction to go.  If 
no Go To or Route is set, this will appear blank or dashes. 

Distance to Next

Distance to Next is the measurement of distance from the user to the next destination point in a 
route.  In a route with multiple points, when the user arrives at one destination point, the unit 
should switch its guidance to the next destination point in the route.  If no Go To or Route is set, 
this will appear blank or dashes.   

Distance to End

Distance to End is the measurement of distance from the user to the final destination point in a 
route.  If no Go To or Route is set, this will appear blank or dashes. 

Time to Next

Time to Next measures how much time it will take the user to arrive at the next destination point 
in a route based on how fast the user is currently moving.  If the user stops moving or moves away 
from the next destination point, this number will become zero.  If no Go To or Route is set, this 
will appear blank or dashes.

Time to End

Time to End measures how much time it will take the user to arrive at the final destination point 
in a route based on how fast the user is currently moving.  If the user stops moving or moves in a 
counterproductive direction, this number will zero out.  If no Go To or Route is set, this will appear 
blank or dashes.

Time

Time displays the current time based on the settings of the active profile.

Date

Date displays the current date based on the settings of the active profile.

Destination

Destination measures the number of degrees a user must turn to match their heading to their 
bearing.  It is displayed in the number of degrees L/R (Left or Right) and is in relation to the user, 
not north.
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Cross Track Error (XTE)

Cross Track Error measures how far the user is off the trail or route.  If no Go To or Route is set, 
this will appear blank or dashes.  

Elevation

Elevation measures the height above or below Sea Level which is 0.

Current Speed

Current Speed measures how fast the user is travelling. 

Average Speed

Average Speed calculates the average speed of the user.

Maximum Speed

Maximum Speed records the highest speed achieved by the user.

Distance Made Good (DMG)

Distance Made Good measures (in distance) the progress the user has made to a final destination 
point. This may be a negative distance if the user moves away from the target point.  If no Go To 
or Route is set, this will appear blank or dashes.

Estimated Time of Arrival (ETA)

Estimated Time of Arrival displays the time of day the user should arrive at a destination.  If no Go 
To or Route is set, this will appear blank or dashes.

Accuracy

Accuracy calculates the margin of error the user can expect based on their satellite reception.  
The smaller the number is, the better the accuracy.  Normally the accuracy is around 10-30 ft (3-
10 m). Things that interfere with satellite reception may decrease the accuracy (increase the 
number) such as heavy canopies from trees, tunnels, tall buildings, canyons, broadcast satellites, 
and other GPS receivers too close in proximity.

Velocity Made Good (VMG)

Velocity Made Good calculates how fast the user is closing their distance to a destination point, 
not how fast the user is moving.  If the user is traveling directly towards the destination point the 
number should match the Current Speed. If the user is travelling off the direct course to a final 
destination point, the number should reflect slower than the Current Speed because less actual 
progress is being made. If the user is moving away from the destination point, the numbers should 
be negative.  If the user is standing still or moving around a consistent radius of the destination 
point, the number should be zero.
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Using the Keyboard

Entering alphanumeric characters into the Magellan Triton is done by the use of the keyboard.  

Key Types Color Sample Description
Alphanumeric Light Blue Enters the alpha, 

numeric or symbol 
character selected.

Cursor Position Medium Blue Moves the character 
cursor to the left or 
right.

Symbol Select  Blue Changes the 
available characters 
to symbols.

Symbol Set Select Medium Blue Available only when 
symbol characters 
are displayed.  Steps 
through three 
different sets of 
symbols and 
navigation terms.
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Extended Character 
Select

Medium Blue Changes the 
available characters 
to extended 
characters.

Numeric Select Blue Changes the 
available characters 
to numeric 
characters.

Alpha Select Blue Changes the 
available characters 
to alphabetic 
characters.

Delete Medium Blue Deletes the character 
to the left of the 
character cursor.
Using the Keyboard 20



Shift Key Medium Blue With alphabetic 
characters shown, 
shifts between upper 
and lower case 
characters.  With 
extended characters 
shown, shifts 
between two 
character sets.  Not 
functional when 
numeric or symbol 
characters are 
displayed.

Return Medium Blue Adds a carriage 
return at the 
character cursor 
position.

Accept Green Saves the text 
entered and applies it 
to the appropriate 
field.

Cancel Red Cancels the text and 
returns to the last 
displayed screen with 
no text changes.
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Date Entry

The Magellan Triton uses a standard calendar display to enter dates for local information and 
waypoint data.  

Use the left and right arrows to change months.  With the desired 
month displayed, select the date to be entered.  (If the day 
portion of the calendar is highlighted you will need to press the 
up arrow until one of the month selector arrows is highlighted.)

Use the arrow cursor to move through the dates.  If one of the 
arrows in the month selector at the top of the display is 
highlighted, press the down arrow to move the highlight to the day 
portion of the calendar. 

Text Size Limitations

Single-line fields:  50 characters.

Multi-line fields (notes, comments, hints): 1024 characters.
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Settings

The Magellan Triton gives you the means to customize the receiver and view details about the 
Magellan Triton receiver.

Customizing Navigation Settings

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select Navigation.

5. Select the option you want to change and press ENTER to 
display the drop down menu.  Select the setting desired.

6. Press ESC to save the changes and return to Settings Menu 
when you have completed changing the navigation settings.

Navigation Settings

Setting Volume and Brightness

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select Volume & Brightness.

5. Highlight the volume or brightness slider bars.

6. Use the left and right arrows on the cursor control or use the touchscreen to adjust the 
volume or brightness.

7. Select the green checkmark when done.

Units Kn / M / Kph
Mi / Ft / Mph
Mi / Yd / Mph
Ntmi / M / Kts
Ntmi / Ft / Kts

Sets the units of measure.

NORTH 
REFERENCE

Magnetic, True Customizes the receiver to use magnetic 
north or true north.

COORDINATE 
SYSTEM

Various Selects the coordinate system to be used 
for displaying position.

MAP DATUM Various Selects the map datum to be used.  The 
Map Datum used by the Magellan Triton 
should match the map datum that is 
being used on paper charts.
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View Memory Usage

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select Memory.

5. Select View Usage.

6. Press ESC when done.

Clearing Memory
Use caution when clearing memory.  This will delete waypoints and routes stored in the receiver and 
cannot be undone.

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select Memory.

5. Select Clear Memory.

6. Select the green checkmark to confirm.

Restoring Factory Settings
Use this option with caution.  You will need to reset any profiles or settings you have previously set.

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select Memory.

5. Select Restore Factory Settings.

6. Select the green checkmark to confirm.

Setting Connectivity
You can set the connectivity through the settings option but please note that every time the Triton is 
connected to a personal computer or an external power source a menu will appear requesting you to 
indicate the connectivity mode for the receiver.  This option is used should you want to change how 
the Triton is connected after it has been connected to a PC or external power source.

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.
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4. Select Connectivity.

5. Select Connect to PC, NMEA - USB, NMEA - Serial, or Power Only.

6. Press ESC to save changes and return to the Settings Menu.

Getting Software Version Information

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select About.

5. Select Version.

6. Press ESC to return to the About Menu.

Viewing Copyright Information

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select About.

5. Select Copyright Info.

6. Press ESC to return to the About Menu.

Personalizing Magellan Triton

1. From the Map screen press MENU.

2. Select View.

3. Select Settings.

4. Select About.

5. Select Owner.

6. Select the field to change (Name, Address, Phone, or EMail).

7. Use the keyboard to enter the information.

8. Select the green checkmark to accept.

9. When done editing the fields, press ESC to return to the About Menu.

Performing Diagnostic Checks

1. From the Map screen press MENU.

2. Select View.
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3. Select Settings.

4. Select Diagnostics.

5. Select Audio Test, Video Test, Keypad Test or Touch Test.

6. Follow the displayed instructions for each test.

7. Press ESC to return to the Diagnostics Menu.
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Profiles

The Magellan Triton gives you the means to set up three profiles; Hiking, Marine and Geocaching.  
Each profile contains custom settings that you can select.  You can customize the profiles to fit your 
particular needs.  You will notice that the background colors for the screens change depending upon 
the profile selected.

Activating a Profile

1. From the Map screen press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile you want to use.

5. Select Activate Profile.

Customizing a Profile
1. From the Map screen press MENU.

2. Select View.

3. Select Profiles.

4. Select the profile you want to use.

5. Use the PAGE / GO TO button to select a tab.

6. When all of the options have been set, use the PAGE / GO TO button to display the Info page 
for the profile and activate the profile.

Display Page

BACKLIGHT 
LEVEL

Off, Low, Medium, 
High

Sets the default backlight level.  To 
conserve battery life, set the backlight 
level to the lowest acceptable setting.

BACKLIGHT 
TIMER

Off, 15 sec, 30 sec, 
60 sec

Sets the time that the backlight will turn 
off without use of the keys or 
touchscreen.

POWER OFF 
TIMER

Off, 5 min, 15 min, 
60 min

Sets the time that the Triton will go into 
suspend mode without use of the keys or 
touchscreen.

TIME FORMAT 12 Hour, 24 Hour Sets the format for how time will be 
displayed.

TIME ZONE Various Select the time zone that you are traveling 
in.

DAYLIGHT 
SAVINGS

On, Off Sets the Magellan Triton time for current 
daylight savings status.  (The Magellan 
Triton does not automatically change 
when daylight savings changes.)

LANGUAGE Various Select the language to be used.
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Map Page

Alerts Page

MAP DETAIL Low, Medium, High Sets the amount of detailed information 
that is displayed on the map to avoid 
clutter.

WAYPOINT 
NAMES

On, Off Sets whether or not waypoint names will 
be displayed on the Map screen.

GEOCACHE 
ICONS

Not Found, All, Off Sets what types of geocache icons will be 
displayed on the Map screen.

PLACE NAMES On, Off Sets whether or not place POIs names will 
be displayed on the Map screen.

TRAIL LINES On, Off Sets whether or not trails will be displayed 
on the Map screen.

ORIENTATION North, Course Sets top of the Map screen display to 
indicate North or your heading (course).

POSITION 
DESTINATION 
LINE

On, Off Sets whether or not the position 
destination line (pink) will be displayed 
on the Map screen.

PLACES 
SHOWN

On, Off Sets whether or not place POIs will be 
displayed on the Map screen.

GPS FIX On, Off When set to on will alert you when the 
Magellan Triton loses GPS signals and 
cannot compute a GPS fix.

ALARM TONE Beep, Ring Sets the type of audible tone to be used.

ALARM 
VOLUME

Off, Low, Medium, 
High

Sets the volume level for the audible 
alarm.

BEEPER 
VOLUME

Off, Low, Medium, 
High

Sets the volume level for the beeper.

BEEPER MODE Keys, Alarms, Keys & 
Alarms

Sets beeper usage.

ANCHOR 
ALARM

Various Sets distance that the Magellan Triton can 
drift from its present position before the 
anchor alarm will sound.

OFF COURSE Various Sets distance that the Magellan Triton can 
be off course before the off course alarm 
will sound.

ARRIVAL On, Off Turns the arrival alert on or off.

WAYPOINT 
PROXIMITY

Various Sets distance that the Magellan Triton will 
alert you to as you approach a waypoint.

GEOCACHE 
PROXIMITY

Various Sets distance that the Magellan Triton will 
alert you to as you a geocache waypoint.
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LOW BATTERY On, Off Sets the alarm to alert you when you have 
a low battery condition.
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Waypoints

Waypoints are the key to navigating and creating routes.  An understanding of waypoints and their use 
is important to get the most out of your Magellan Triton.

In its simplest form, a waypoint is a point on the map.  The Magellan Triton uses waypoints much the 
same as you use addresses to get from your home to your destination.   With information on where you 
are and a waypoint of where you want to go, the Triton can provide the necessary information to get 
you there.

The Magellan Triton has three different classifications for waypoints; User-Created, Place and 
Geocache waypoints.  

User-created waypoints are waypoints you define.  This can be done by saving your current 
location, picking a point on the map or by entering waypoint coordinates.

Place waypoints are waypoints that have been preloaded into the base map or one of the optional 
detail maps.  You cannot add Place waypoints but you can use them when creating a route.

Geocache waypoints are special waypoints that are used for geocaching.  More information on 
geocache waypoints can be found in the chapter on geocaching, but they are used the same as 
user-created and place waypoints in creating a route.

Waypoint Detail Screen Overview

Whenever a waypoint is being created, the Waypoint Detail screen is 
displayed.  This screen provides a way to enter data, modify existing 
data, add media or set alarm requirements for the waypoint.  

The Magellan Triton automatically assigns a name for the waypoint using 
the convention of WPxxxx for newly created waypoints.  It is a good 
practice, and will avoid confusion later, if you enter a unique name for 
each waypoint. 

The Waypoint Details screen consists of three pages that can be 
accessed by pressing the PAGE / GO TO button or by tapping on the icon 
at the top of the display.

* Note that media assigned to the waypoint is stored on the SD card and not in the Triton's internal 
memory.

Waypoint 
Information

Used to enter or modify data for the waypoint.  This screen also provides 
information on the direction and distance to the waypoint from your 
current location.

The green checkmark is for accepting the waypoint and saving it to the 
Triton memory.

Media Used to attach a media file to the waypoint.

Select Add Media to assign an image, video or audio clip to the waypoint.

Options Set proximity alarm for the waypoint, duplicate the waypoint or delete the 
waypoint.
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Creating Waypoints

Creating a Current Location Waypoint from the Map Screen

1. While viewing the Map screen, press ENTER.

2. Select Create Waypoint.

3. The Waypoint Details screen is displayed with the latitude, longitude and elevation for your 
current location.

4. Edit the waypoint information as needed.  

5. Select the Media page to add media or the Options page to turn the proximity alarm on or 
off.

6. Select the green checkmark to save the waypoint.

Creating a Current Location Waypoint Using the Triton Menu

1. While viewing the Map screen, press MENU.

2. Select Create.

3. Select Waypoint.

4. Select Current Location.

5. The Waypoint Details screen is displayed with the latitude, longitude and elevation for your 
current location.

6. Edit the waypoint information as needed.  

7. Select the Media page to add media or the Options page to turn the proximity alarm on or 
off.

8. Select the green checkmark to save the waypoint.

Creating a Waypoint Using the Pan Cursor

1. While viewing the Map screen, use the arrow keys to move the pan cursor to the location on 
the map you want to create a waypoint.

2. Press ENTER.

3. Select Create Waypoint.

4. The Waypoint Details screen is displayed with the latitude and longitude for the pan cursor 
position.

5. Edit the waypoint information as needed.  

6. Select the Media page to add media or the Options page to turn the proximity alarm on or 
off.

7. Select the green checkmark to save the waypoint.
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Creating a Waypoint from a Point on the Map Using the Triton Menu

1. While viewing the Map screen, press MENU.

2. Select Create.

3. Select Waypoint.

4. Select Point on Map.

5. The Map screen is displayed.  Use the arrow keypad to move the pan cursor to the point on 
the map desired.

6. Press ENTER.

7. The Waypoint Details screen is displayed with the latitude and longitude for the cursor 
position.

8. Edit the waypoint information as needed.  

9. Select the Media page to add media or the Options page to turn the proximity alarm on or 
off.

10. Select the green checkmark to save the waypoint.

Creating a Custom Waypoint from the Map Screen

1. While viewing the Map Screen, press ENTER. 

2. Select Create Waypoint.

3. The Waypoint Details screen is displayed with the latitude, longitude and elevation for your 
current location or the position of the pan cursor.

4. Select the latitude field (LAT).

5. Use the keyboard to enter the latitude for the waypoint.  Select the green checkmark when 
done.

6. Select the longitude field (LONG).

7. Use the keyboard to enter the longitude for the waypoint.  Select the green checkmark when 
done.

8. Optional:  Select the elevation field (ELEVATION) and enter the elevation for the waypoint.  
Select the green checkmark when done.

9. Enter other waypoint information as needed.  

10. Select the Media page to add media or the Options page to turn the proximity alarm on or 
off.

11. Select the green checkmark to save the waypoint.

Creating a Custom Waypoint Using the Triton Menu

1. While viewing the Map screen, press MENU.

2. Select Create.
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3. Select Waypoint.

4. Select Coordinates.

5. The Waypoint Details screen is displayed with the latitude and longitude for your current 
location or the pan cursor position.

6. Select the latitude field (LAT).

7. Use the keyboard to enter the latitude for the waypoint.  Select the green checkmark when 
done.

8. Select the longitude field (LONG).

9. Use the keyboard to enter the longitude for the waypoint.  Select the green checkmark when 
done.

10. Optional:  Select the elevation field (ELEVATION) and enter the elevation for the waypoint.  
Select the green checkmark when done.

11. Enter other waypoint information as needed.  

12. Select the Media page to add media or the Options page to turn the proximity alarm on or 
off.

13. Select the green checkmark to save the waypoint.

Viewing Waypoints

Viewing a Saved Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Waypoint.

4. Change the order that the waypoints are displayed, if needed, or 
search for a waypoint.  (Select the Search field under the 
Select Waypoint header.  Select the order you want the 
waypoints listed, either by nearest, date added, or by name.  To 
do a search, select Search and using the keyboard, enter the 
first few characters of the waypoint.)

5. Select the waypoint you want to view from the list of waypoints 
and press ENTER.

6. When the waypoint name is highlighted, select the View icon to 
the left of the waypoint name.

7. The Waypoint Details screen is displayed.

8. Press ESC to save the waypoint and return to the Waypoint List.  
Pressing ENTER to save the changes and create a Go To route to the waypoint.
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Editing Waypoints

Editing a Saved Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Waypoint.

4. Change the order that the waypoints are displayed, if needed, or search for a waypoint.   
(Select the Search field under the Select Waypoint header.  Select the order you want the 
waypoints listed, either by nearest, date added, or by name.  To do a search, select Search 
and using the keyboard, enter the first few characters of the waypoint.)

5. Select the waypoint you want to edit from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name.

7. The Waypoint Details screen is displayed.

8. Select the fields you want to change and enter the new information.

9. Use the PAGE / GO TO button to select the Media page to add or remove media files, or the 
Options page to set the proximity alarm on or off.

10. Press ESC to save the waypoint.  (Pressing ENTER will create a Go To route to that 
waypoint.)

Deleting a Saved Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Waypoint.

4. Change the order that the waypoints are displayed, if needed, or search for a waypoint.  
(Select the Search field under the Select Waypoint header.  Select the order you want the 
waypoints listed, either by nearest, date added, or by name.  To do a search, select Search 
and using the keyboard, enter the first few characters of the waypoint.)

5. Select the waypoint you want to delete from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the Delete icon to the right of 
the waypoint name.

7. Confirm the deletion by selecting the green checkmark.

Deleting a Saved Waypoint (Alternate Method)

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Waypoint.
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4. Change the order that the waypoints are displayed, if needed, or search for a waypoint. 
(Select the Search field under the Select Waypoint header.  Select the order you want the 
waypoints listed, either by nearest, date added, or by name.  To do a search, select Search 
and using the keyboard, enter the first few characters of the waypoint.)

5. Select the waypoint you want to delete from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name.

7. Use the PAGE / GO TO button to display the Options page.

8. Select Delete Waypoint.

9. Confirm the deletion by selecting the green checkmark.

Duplicating a Saved Waypoint 

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Waypoint.

4. Change the order that the waypoints are displayed, if needed, or search for a waypoint.  
(Select the Search field under the Select Waypoint header.  Select the order you want the 
waypoints listed, either by nearest, date added, or by name.  To do a search, select Search 
and using the keyboard, enter the first few characters of the waypoint.)

5. Select the waypoint you want to duplicate from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name.

7. Use the PAGE / GO TO button to display the Options page.

8. Select Duplicate Waypoint.

9. Confirm the duplication of the waypoint by selecting the green checkmark.

10. Use the keyboard to enter the waypoint name.

11. Select the green checkmark to save the waypoint with the new name.

12. Accept the Waypoint Duplication notice.

13. The waypoint is duplicated and you are returned to the Waypoints Display page.
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Geocache Waypoints

Geocaching is a popular activity with GPS users.  People will hide caches (“treasures”) and record the 
latitude and longitude for the cache.  They post these locations on geocaching web sites that can be 
found on the internet.  You then enter these geocache waypoints into your Magellan Triton either by 
creating a geocache waypoint or by saving the geocache file from the internet, adding it to the 
VantagePoint software and uploading it into the Magellan Triton.

For additional information on geocaching and geocaching events, go to http://www.geocaching.com or 
do a search on geocaching for other geocaching sites.  Premium members of Geocaching.com can 
transfer .gpx files directly into the VantagePoint software and then transfer the information into their 
Magellan Triton.

Creating a Geocache Waypoint
You may want to create a new geocache waypoint for others to find or you may want to input a 
geocache waypoint that someone else has established that you can use the Magellan Triton to find.

1. From the Map screen, press MENU.

2. Select Create.

3. Select Geocache.

4. Select from Current Location, Point on Map or Coordinates.  (If you are marking a new cache 
location you would probably select current location.  If you are entering waypoint 
information manually, you could select current location or Coordinates.)

5. The Geocache Waypoint Details Information page is displayed.  
On this page you can edit the waypoint the same as a user-
created waypoint.  The Geocache Waypoint Information page 
also includes Difficulty (1 through 5 with 5 being the most 
difficult), Terrain (1 though 5 with 5 being the most difficult), 
and the name of the person who hid the cache (Hider).

6. Press the PAGE / GO TO button to display the Details page.  
Some geocaches will have hints included to help in finding the 
cache.  Select the desired field and use the keyboard to enter 
the hint and descriptions.

7. Press PAGE / GO TO to add media (image, video or audio) from 
the SD card installed in the Triton.

8. Press PAGE / GO TO to access the Options page where you can turn the proximity alarm on 
or off.

9. Press PAGE / GO TO again to return to the Information page.  Select the green checkmark to 
save the geocache waypoint.

Editing a Saved Geocache Waypoint 

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Geocache.
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4. Change the order that the geocache waypoints are displayed, if needed, or search for a 
geocache waypoint.  (Select the Search field under the Select Waypoint header.  Select the 
order you want the waypoints listed, either by nearest, date added, or by name.  To do a 
search, select Search and using the keyboard, enter the first few characters of the 
waypoint.)

5. Select the waypoint you want to view from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name.

7. The Geocache Waypoint Details screen is displayed.  

8. Use the PAGE / GO TO button to select the page to view.  Select the desired field to change 
and use the keyboard to make the changes.  Select the green checkmark to save the 
changes and return to the Geocache Waypoint Details page.

9. Press ESC to exit.  (Pressing ENTER will create a Go To route to that waypoint.) 

Deleting a Saved Geocache Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Geocache.

4. Change the order that the geocache waypoints are displayed, if 
needed, or search for a geocache waypoint. (Select the Search 
field under the Select Waypoint header.  Select the order you 
want the waypoints listed, either by nearest, date added, or by 
name.  To do a search, select Search and using the keyboard, 
enter the first few characters of the waypoint.)

5. Select the waypoint you want to delete from the list of 
waypoints.

6. When the waypoint name is highlighted press ENTER.  Select 
the Delete icon to the right of the waypoint name.

7. Confirm the deletion by selecting the green checkmark.

Deleting a Saved Geocache Waypoint (Alternate Method)

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Geocache.

4. Change the order that the geocache waypoints are displayed, if needed, or search for a 
geocache waypoint.  (Select the Search field under the Select Waypoint header.  Select the 
order you want the waypoints listed, either by nearest, date added, or by name.  To do a 
search, select Search and using the keyboard, enter the first few characters of the 
waypoint.))

5. Select the waypoint you want to delete from the list of waypoints.
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6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name and press ENTER.

7. Use the PAGE / GO TO button to display the Options page.

8. Select Delete Waypoint.

9. Confirm the deletion by selecting the green checkmark.

Duplicating a Saved Geocache Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Geocache.

4. Change the order that the geocache waypoints are displayed, if needed, or search for a 
geocache waypoint.  (Select the Search field under the Select Waypoint header.  Select the 
order you want the waypoints listed, either by nearest, date added, or by name.  To do a 
search, select Search and using the keyboard, enter the first few characters of the 
waypoint.)

5. Select the waypoint you want to duplicate from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name and press ENTER.

7. Use the PAGE / GO TO button to display the Options page.

8. Select Duplicate Waypoint.

9. Confirm the duplication of the waypoint by selecting the green checkmark.

10. Use the keyboard to enter the waypoint name.

11. Select the green checkmark to save the waypoint with the new name.

12. Accept the Waypoint Duplication notice.

13. The waypoint is duplicated and you are returned to the Geocache Waypoints Display page.
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Routes

There are two types of routes that are commonly used in the Magellan Triton, Go To route and Multileg 
route.  A third type of route, Backtrack route, is also commonly used and is described in the chapter 
on Trails.

A Go To route is the simplest route possible.  It begins at your current location and goes to a single 
destination you select.  This is often referred to as a single leg route.  An example would be you are at 
your camp and want to go back to a scenic area you saved as a waypoint during your last hike.  You 
would create a Go To route by selecting the waypoint for the scenic area as the destination.  The 
Magellan Triton would then plot a straight line from your location to the destination waypoint and 
provide you with updated information as you travel to get you to your destination.  As you hike, the 
Magellan Triton continuously updates the information giving you the best possible directions to get 
you to your destination.

A Multileg route is a series of Go To routes strung together.  Using the same scenario as above, only 
this time you want to go to get supplies first and you know the position of a bridge you need to cross.  
For this route it would go from your current location, to the store, to the bridge and finally to the 
scenic spot.  This multileg route consists of three Go To routes.  Once the route is activated, the 
Magellan Triton will begin providing navigation information to get you to the store.  After arriving at 
the store it will automatically begin providing information to get you to the bridge, and then the scenic 
spot.  Another useful feature of multileg routes is that they can be saved into memory and used over 
and over.

Tip:  If you want to save a single leg go to route into memory, use the Create Route function and 
create a route with one leg.

Go To Routes

Creating a Go To Route Using the Pan Cursor
This method provides you a way of looking at the map and moving the cursor to the point on the 
map you want to go to without requiring that you have latitude and longitude information for the 
destination.

1. From the Map screen, use the arrow keys or touch screen to move the cursor to the point you 
want to go to.

2. Press ENTER to access the menu.

3. Select Go To.

4. The Map screen is displayed with the Go To route shown.  A start icon (green flag) and a 
destination icon (red flag) is displayed along with a Destination Position Line connecting the 
two flags.

Creating a Go To Route to a Saved User-Created Waypoint.

1. From the Map screen press MENU.  (Alternate Method:  Press and hold the GO TO button 
while the present position cursor is displayed on the Map screen.)

2. Select Go To.

3. Select Waypoint.

4. If needed, change the order that the waypoints are displayed or search for a waypoint.  
(Select the Search field under the Select Waypoint header.  Select the order you want the 
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waypoints listed, either by nearest, date added, or by name.  To do a search, select Search 
and using the keyboard, enter the first few characters of the waypoint.)

5. Select the waypoint you want to go to from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select 
the View icon to the left of the waypoint name.

7. The Waypoint Details screen is shown with the Information page 
displayed.  

8. With the Go To icon (arrow) highlighted press ENTER or tap on 
the icon.

9. The Map screen is displayed with a preview of the route shown.  
The total distance for the route is displayed at the top of the 
screen.

10. Press ENTER or tap on the Go To icon again to begin the route.

Creating a Go To Route to a Place Waypoint

1. From the Map screen press MENU.  (Alternate Method:  Press and hold the GO TO button 
while the present position cursor is displayed on the Map screen.)

2. Select Go To.

3. Select Place. 

4. Select the Map.  (Only the background map is displayed if no detailed maps are installed.)

5. Select the Category and Subcategory.  (Not all categories will have a subcategory.)

6. Select Nearest to view the waypoints in the category sorted by 
the distance from your current location or do a search on a 
waypoint.  (Select the Search field under the Places header to 
display the drop-down menu.  Select if you want the waypoints 
listed by nearest or if you want to do a search.  Select Search to 
display the keyboard and enter the first few characters for a 
waypoint you are looking for.)

7. Select the waypoint you want to go to from the list of waypoints 
and press ENTER.

8. The Waypoint Details screen is shown with the Information page 
displayed.  

9. With the Go To icon (arrow) highlighted press ENTER or tap on 
the icon.

10. The Map screen is displayed with a preview of the route shown.  The total distance for the 
route is displayed at the top of the screen.

11. Press ENTER or tap on the Go To icon again to begin the route.
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Creating a Go To Route to a Geocache Waypoint

1. From the Map screen press MENU.  (Alternate Method:  Press and hold the GO TO button 
while the present position cursor is displayed on the Map screen.)

2. Select Go To.

3. Select Geocache.

4. If needed, change the order that the waypoints are displayed or search for a waypoint.   
((Select the Search field under the Select Waypoint header.  Select the order you want the 
waypoints listed, either by nearest, date added, or by name.  To do a search, select Search 
and using the keyboard, enter the first few characters of the waypoint.)

5. Select the waypoint you want to go to from the list of waypoints.

6. When the waypoint name is highlighted press ENTER.  Select the View icon to the left of the 
waypoint name.

7. The Geocache Waypoint Details screen is shown with the Information page displayed.  

8. With the Go To icon (arrow) highlighted press ENTER or tap on the icon.

9. The Map screen is displayed with a preview of the route shown.  The total distance for the 
route is displayed at the top of the screen.

10. Press ENTER or tap on the Go To icon again to begin the route.

Creating a Multileg Route

1. From the Map screen press MENU.

2. Select Create.

3. Select Route.

4. Select the method for determining the starting location for the 
route.

Current Location:  The Waypoint Details page is shown with the 
Information page displayed.  Select the green checkmark to use 
this waypoint.

Point on Map:  Use the arrow keys or use the touchscreen to 
scroll around the map until the pan cursor is on the point 
desired.  Press ENTER.  When the Waypoint Details page is 
displayed, make any necessary edits and select the green 

checkmark.

Waypoint:  Select a waypoint from the list of saved user-created 
waypoints and press ENTER.

Geocache: Select a waypoint from the list of saved geocache waypoints and press ENTER.

Place:   Select the map to be used.  Select the category (and subcategory if required).  
Select a waypoint from the list of Place waypoints and press ENTER.
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5. The Route Create screen is displayed with the waypoint you selected as the starting waypoint 
as the only item in the list.

6. Select Add Point.

7. Select the method for determining the next destination in the route.  The same options as 
explained in step 4 apply.

8. Continue adding waypoints to the route list until the route is complete.

9. Check the route and make necessary changes.

Deleting one of the route leg destinations:  Select the destination waypoint and choose the 
delete (trash can) icon to the right.  Confirm the deletion.  (This does not remove the 
waypoint from the Triton’s memory, only from the route.)

Viewing the route:  Select the View icon in the action bar next to Add Point.  The Map screen 
is displayed with a graphical representation of the route.

10. When the route is correct, select Done in the action header bar. 

11. Select Save Route.  

12. The route has been assigned a default name.  To change the name, select the button with 
the default name (RouteXXX).  Use the keyboard to enter the desired name for the route.  
Select the green checkmark when done.

13. Select Save.

14. The newly created route is saved and stored in memory.

Activating a Multileg Route

1. From the Map screen press MENU.

2. Select Go To.

3. Select Route.

4. If needed, change the order that the waypoints are displayed or search for a waypoint.   
(Select the Search field under the Go to route header.  Select the order you want the 
waypoints listed, by date added or name.  Select search to enter the first few characters for 
a route you want to search for.)

5. Select the route and press ENTER.

6. A preview of the route is displayed.

7. Press ENTER or tap on the Go To icon.
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Deleting a Multileg Route

1. From the Map screen press MENU.

2. Select Go To.

3. Select Route.

4. If needed, change the order that the waypoints are displayed or search for a waypoint.  
(Select the Search field under the Go To route header.  Select the order you want the 
waypoints listed, by date added or name.  Select search to enter the first few characters for 
a route you want to search for.)

5. Select the route.

6. Press the right arrow.  

7. Press the PAGE button twice or tap on the Options tab.

8. Select Delete Route.

9. Confirm the route deletion.

Duplicating a Multileg Route 

1. From the Map screen press MENU.

2. Select Go To.

3. Select Route.

4. If needed, change the order that the waypoints are displayed or search for a waypoint.  
(Select the Search field under the Go to route header.  Select the order you want the 
waypoints listed, by date added or name.  Select search to enter the first few characters for 
a route you want to search for.)

5. Select the route.

6. Press the right arrow.  

7. Press the PAGE button twice or tap on the Options tab.

8. Select Duplicate Route.

9. Confirm the route duplication.

10. Enter a new name for the route. 

11. Select the green checkmark when done.

Viewing a Route’s Vertical Profile
The Vertical Profile screen graphically displays the changes in elevation for your route.  (Please note 
that a detailed map be loaded for the area that the route is in for the vertical profile to be computed 
properly.)  

Use the green and red vertical sliders at the top of the display to change the visible start and end 
times.  In the graphical area you can use the arrow keys or tap on the display to see the elevation for 
a specific position indicated by the dot icon.
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1. From the Map screen press MENU.

2. Select Go To.

3. Select Route.

4. Change the order that the saved routes are displayed if needed or do a search on a route.  
(Select the Search field under the Go to route header.  Select the order you want the 
waypoints listed, by date added or name.  Select search to enter the first few characters for 
a route you want to search for.)

5. Select the route.

6. Press the right arrow.  

7. Select Vertical Profile.

8. Select the green checkmark when done viewing the vertical profile.

Cancelling a Route

1. From the Map screen press ENTER.

2. Select Cancel Route.

3. Confirm the cancellation by selecting the green checkmark.
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Trails

As you travel with the Magellan Triton on and computing your position, the Magellan Triton 
automatically drops electronic breadcrumbs to record your travels.  These breadcrumbs are temporary 
waypoints that are created and stored while you travel.  You can set the intervals that they are created 
in the Tracks Option function described in this chapter.

The common term for these breadcrumbs is track.  You may be familiar with this term from other 
navigation devices you’ve used.  A trail is taking the current track and saving it into memory.  This 
trail can be used again like any other saved route.

An important safety feature of a trail is the Backtrack option.  Since the Triton is recording your 
movement, it can be used to reverse this track and provide navigation information back to your 
starting point, following the same path you have just taken.

Tip: Whenever beginning a hike that you might want to use backtrack route with, clear the track 
memory (described in this chapter) before beginning the hike.

Trails are displayed on the Map screen as dotted lines.

Creating a Trail
Once you begin traveling with the Magellan Triton, it will begin to store track information.  If you 
want to save this track to be used again, you need to follow the steps provided here.

1. From the Map screen press MENU.

2. Select Create.

3. Select Trail.

4. Use the keyboard to enter a name for the trail or use the default name supplied.

5. Select the green checkmark to accept and save the trail.

Creating a Trail (Alternate method)

1. From the Map screen press MENU.

2. Select View.

3. Select Tracks.

4. Select Save Track.

5. Use the keyboard to enter a name for the trail or use the default name supplied.

6. Select the green checkmark to accept and save the trail.

Activating a Trail

1. From the Map screen press MENU.

2. Select Go To.

3. Select Trail.

4. Trails are displayed sorted by name.  You can change the order that the trails are displayed 
or do a search on a trail.  (Select the Search field under the Select Trail header.  Select the 
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order you want the trail listed, by name or date added.  Select search to enter the first few 
characters for a trail you are looking for.)

5. Select the trail you want to go to from the list of trails and press ENTER.

6. When the trail name is highlighted, select the View icon to the left of the trail name.

Before activating the trail you can view the vertical profile for the trail by selecting Vertical 

Profile and pressing ENTER.

You can change the color that is used to display the trail by highlighting the color icon to the 
left of the trail name and press ENTER.

7. Press ENTER.

8. The Trail Info screen is displayed.  Select the Go To arrow icon.

9. The Map screen is displayed with the trail graphically displayed. Select the Go To arrow icon 
to activate the trail.

Deleting a Trail

1. From the Map screen press MENU.

2. Select Go To.

3. Select Trail.

4. Change the order that the trails are displayed if needed or do a search on a trail.  (Select the 
Search field under the Select Trail header.  Select the order you want the trail listed, by 
name or date added.  Select search to enter the first few characters for a trail you want to 
search for.)

5. Select the trail you want to delete from the list of trails.

6. When the trail name is highlighted press ENTER and select the Trash Can icon to the right of 
the trail name.

7. Select the green checkmark to confirm deletion.

Deleting a Trail (Alternate Method)

1. From the Map screen press MENU.

2. Select Go To.

3. Select Trail.

4. Change the order that the trails are displayed if needed or do a search on a trail.  (Select the 
Search field under the Select Trail header.  Select the order you want the trail listed, by 
name or date added.  Select search to enter the first few characters for a trail you want to 
search for.)

5. Select the trail you want to delete from the list of trails and press ENTER.

6. Select the View icon to the left of the trail name.

7. Press the PAGE / GO TO button to display the Options page.
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8. Select Delete Trail.

9. Select the green checkmark to confirm deletion.

Duplicating a Trail 

1. From the Map screen press MENU.

2. Select Go To.

3. Select Trail.

4. Change the order that the trails are displayed, if needed, or search for a trail.  (Select the 
Search field under the Select Trail header.  Select the order you want the trail listed, by 
name or date added.  Select search to enter the first few characters for a trail you want to 
search for.)

5. Select the trail you want to duplicate from the list of trails.

6. When the trail name is highlighted press ENTER.  Select the View icon to the left of the trail 
name.

7. Press the PAGE / GO TO button to display the Options page.

8. Select Duplicate Trail.

9. Enter a name for the trail.

10. Select the green checkmark.

Reversing a Trail 

1. From the Map screen press MENU.

2. Select Go To.

3. Select Trail.

4. Change the order that the trails are displayed, if needed, or search for a trail.  (Select the 
Search field under the Select Trail header.  Select the order you want the trail listed, by 
name or date added.  Select search to enter the first few characters for a trail you want to 
search for.)

5. Select the trail you want to reverse from the list of trails.

6. When the trail name is highlighted and press ENTER.  Select the View icon to the left of the 
trail name.

7. Press the PAGE / GO TO button to display the Options page.

8. Select Reverse Trail.

9. Select the green checkmark.
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Hiding/Showing a Trail 

1. From the Map screen press MENU.

2. Select Go To.

3. Select Trail.

4. Change the order that the trails are displayed, if needed, or search for a trail.  (Select the 
Search field under the Select Trail header.  Select the order you want the trail listed, by 
name or date added.  Select search to enter the first few characters for a trail you want to 
search for.)

5. Select the trail you want to hide or show from the list of trails.

6. When the trail name is highlighted and press ENTER.  Select the View icon to the left of the 
trail name.

7. Press the PAGE / GO TO button to display the Options page.

8. Select Hide Trail or Show Trail.

Activating a Backtrack Route
Many might consider a Backtrack route as the most important function in a handheld GPS receiver.  
Being able to quickly create a route back to your starting point is not only handy for normal outdoor 
adventures, but also gives the traveller the security in knowing that directions back to camp are only 
a button press away.

1. From the Map screen press ENTER.

2. Select Backtrack.

3. Select the green checkmark.

4. Accept the notification that the backtrack has been started.

Clearing Track
As mentioned earlier, you should clear your track before travelling if you plan on saving the track as 
a trail.

1. From the Map screen press MENU.

2. Select View.

3. Select Tracks.

4. Select Erase Track.

5. Select the green checkmark to confirm.  The existing track is erased and you can begin your 
journey.
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Places

Places are waypoints that are part of the base map that is installed in your Magellan Triton.  These 
waypoints can’t be deleted or duplicated but they can be used as the destination for a Go To route or 
a multileg route.  Places are categorized as roads, world maps, waterways or city centers.  When 
searching for a Place waypoint, you will need to select the category to narrow down the search.

Place waypoints are also found in the optional mapping software available from Magellan.  (Check the 
Magellan website at www.magellangps.com for availability of additional detailed maps.) 

Searching for a Place Waypoint (base map)

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Place.

4. From the Select Map display, select BACKGROUND MAPS.  (If you do not have any detailed 
maps loaded, Background Maps will be the only option.)

5. Select the category.  (Roads, World_Map, Waterways, Cities)

6. Select Nearest to view the waypoints in the category sorted by the distance from your current 
location or do a search on a waypoint.  (Select the Search field under the Places header.  
Select if you want the waypoints listed by nearest or if you want to do a search.  Selecting 
search brings up the keyboard so you can enter the first few characters for a waypoint you 
want to search for.)

7. Select the waypoint name from the list of waypoints.  The Waypoint Detail screen is 
displayed.

8. Use the PAGE / GO TO button to switch between the Information Page and the Options Page. 

9. Press ESC when you are finished viewing the Place waypoint.

Searching for a Place Waypoint (Detail Map)

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Place.

4. From the Select Map display, select the detailed map.  (If you do not have any detailed maps 
loaded, Background Maps will be the only option.)
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5. Select the category or All Categories.

6. Select the subcategory or All Subcategories if available.

7. Select Nearest to view the waypoints in the category sorted by 
the distance from your current location (or cursor position if in 
pan mode) or do a search on a waypoint.  (Select the Search 
field under the Places header.  Select if you want the waypoints 
listed by nearest or if you want to do a search.  Selecting search 
brings up the keyboard so you can enter the first few characters 
for a waypoint you want to search for.)

8. Select the waypoint name from the list of waypoints.  The 
Waypoint Detail screen is displayed.

9. Use the PAGE / GO TO button to switch between the 
Information Page and the Options Page.

10. Press ESC when you are finished viewing the Place waypoint.

Turning On/Off the Waypoint Proximity Alarm for a Place Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Place.

4. From the Select Map display, select the background map or the detailed map for the 
waypoint.  (If you do not have any detailed maps loaded, Background Maps will be the only 
option.)

5. Select the category or All Categories.

6. Select the subcategory or All Subcategories if available.

7. Select Nearest to view the waypoints in the category sorted by 
the distance from your current location or do a search on a 
waypoint.  (Select the Search field under the Places header.  
Select if you want the waypoints listed by nearest or if you want 
to do a search.  Selecting search brings up the keyboard so you 
can enter the first few characters for a waypoint you want to 
search for.)

8. Select the waypoint name from the list of waypoints and press 
ENTER.  Select the View icon to the left.  The Waypoint Detail 
screen is displayed.

9. Use the PAGE / GO TO button to switch to the Options Page. 

10. Select the Alert button to turn the alarm on or off.

11. Press ENTER to save your selection.
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Viewing Best Fish and Hunt Times for a Place Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Place.

4. From the Select Map display, select the background map or the detailed map for the 
waypoint.  (If you do not have any detailed maps loaded, Background Maps will be the only 
option.)

5. Select the category or All Categories.

6. Select the subcategory or All Subcategories if available.

7. Select Nearest to view the waypoints in the category sorted by 
the distance from your current location or do a search on a 
waypoint.  (Select the Search field under the Places header.  
Select if you want the waypoints listed by nearest or if you want 
to do a search.  Selecting search brings up the keyboard so you 
can enter the first few characters for a waypoint you want to 
search for.)

8. Select the waypoint name from the list of waypoints and press 
ENTER.  Select the View icon to the left.  The Waypoint Detail 
screen is displayed.

9. Use the PAGE / GO TO button to switch to the Options Page. 

10. Select Local Info.

11. Select Fish and Hunt.

12. Select the arrows at the top of the display to scroll through the dates.  Tap the date 
displayed at the top of the display to use the calendar to select a date.

13. Press the green checkmark when done.

Viewing Sun and Moon Rise and Set Times for a Place Waypoint

1. From the Map screen, press MENU.

2. Select Go To.

3. Select Place.

4. From the Select Map display, select the background map or the detailed map for the 
waypoint.  (If you do not have any detailed maps loaded, Background Maps will be the only 
option.)

5. Select the category or All Categories.

6. Select the subcategory or All Subcategories if available.

7. Select Nearest to view the waypoints in the category sorted by the distance from your current 
location or do a search on a waypoint.  (Select the Search field under the Places header.  
Select if you want the waypoints listed by nearest or if you want to do a search.  Selecting 
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search brings up the keyboard so you can enter the first few characters for a waypoint you 
want to search for.)

8. Select the waypoint name from the list of waypoints and press ENTER.  Select the View icon 
to the left.  The Waypoint Detail screen is displayed.

9. Use the PAGE / GO TO button to switch to the Options Page. 

10. Select Local Info.

11. Select Sun and Moon.

12. Select the arrows at the top of the display to scroll through the dates.  Tap the date 
displayed at the top of the display to use the calendar to select a date.

13. Press the green checkmark when done.
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Media

Before using any of the media options you need install an optional SD card with the images, video or 
sound files in the SD card slot located on the right side of the Magellan Triton.

Browsing Photographs and Videos

1. Press MENU.

2. Select View.

3. Select Media.

4. Select Browse > Photos and Videos.

5. Select the Sort button at the top to choose how the images will be sorted – by date, distance 
or name.

6. Select an image to display the image in full screen.

Tapping on the screen or pressing the up and down arrows while viewing a photograph will 
rotate the image between portrait and landscape modes.

7. Use the Left and Right Arrow keypad to step through the saved photos and videos.

8. Press ESC to return to the Browse Photos list.

9. Tap on Grid View at the bottom of the display to change how the images are displayed.

10. While in Grid View, tap on Calendar to select a date that images were recorded.

11. Press ESC to exit Browsing Photographs and Videos.

Playing Stored Music Files

1. Press MENU.

2. Select View.

3. Select Media.

4. Select Browse > Music and Audio.

5. Select Music.

6. Select the category to list stored music.

7. Select a music file from the list.  The Music Player is displayed.

Zoom - / + Zoom Changes the volume.
Pause / Play Pauses the music / once paused, 

continues to play the music.
Rewind Select and hold to rewind the music file.
Fast Forward Select and hold to fast forward through 

the music file.
Time Slider Bar Use the touchscreen to move the slider.
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8. Use the MENU Button to display options for the music file being played.

Changing Music File Settings

1. Press MENU.

2. Select View.

3. Select Media.

4. Select Browse > Music and Audio.

5. Select Settings.

6. Press ESC to save settings and exit.

Playing Stored Audio Files

1. Press MENU.

2. Select View.

3. Select Media.

4. Select Browse > Music and Audio.

5. Select Recordings.

6. Select the order that the recordings are displayed (Nearest, Name, or Date).

Add to Playlist… Adds the music file to an existing playlist 
or provides the option of creating a new 
playlist.

Details Displays details for the music file being 
played.  (Name, length, album track, 
genre, size, format and channels.)

Shuffle / Play Album Shuffles the order that music files are 
played in the active playlist.  Turns shuffle 
off and plays the music files as they are 
stored in the playlist.

Main Media Menu Returns to the Media Menu.
Return to Map Displays the Map screen with the music 

files being played.

Shuffle Select to turn shuffle on or off.
Repeat Select to set repeat playing the songs on 

or off.
EQ (Equalizer) Select the type of equalizer desired for the 

music files being played (Default, Rock, 
Classical, Country, Industrial Hardcore).
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7. Select the desired recording.

8. The Now Playing screen is displayed with the latitude and longitude information shown for 
the recording.

Use the MENU Button to display options for the music file being played.

Zoom - / + Zoom Changes the volume.
Pause / Play Pauses the music / once paused, 

continues to play the music.
Rewind Select and hold to rewind the music file.
Fast Forward Select and hold to fast forward through 

the music file.

Details Displays details for the recording file 
being played.  (Name, location, length, 
track and genre)

Attach To… Displays the waypoint list.  Select the 
waypoint you want the recording saved to.

Main Media Menu Returns to the Media Menu.
Return to Map Displays the Map screen with the music 

files being played.
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